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Chapter 1   

1.1Introduction 
 

Floods are one of the most dangerous natural phenomena that negatively affect 

human life. They can destroy infrastructures and parts of cities and villages, and 

more dangerous, may kill many people. Flood is composed by water rafting which 

is very large and considerably above normal levels. Geographic Information 

Systems (GIS) and remote sensing play an active role in monitoring and reducing 

natural disasters.  

A GIS is a computer-based system that allows for the collection, maintenance, 

storage, analysis and output and distribution of spatial data and information. These 

systems are collecting data for management and processing for analysis and 

simulations – finally results are displayed and the output may help for planning and 

decision making, in particular for emergency responses, Remote Sensing is a major 

source of geographical data. 

 
1.2 Problem Statement 

 
In Sudan, the people face flood hazards, especially in Alsalha-algeaa region, 

in which every year people are suffering from this problem. The Study Area is 

exposed annually to floods  no maps are helping to reduce the damage of floods . 

and There is no research going on to solve this problem. 
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1.3 Research Importance 

 
This study will promote GIS technologies as an early warning system to 

deliver the necessary precautions for Omdurman (Alsalha), to avoid or minimize 

losses and making contributions to the preservation of life, property and the 

continuation of life. 

 
1.4 Research Hypothesis 

 

 Using GIS technology for data collection, storage, and analysis to increase 

and improve the accuracy of the information which would lead to flood forecasting 

and emergency responses. 

 

1.5 Objectives 

 
The main objective of this research is to study the potential of GIS and the role it 

can play in thedeveloped GIS based system for the management of flood disasters 

in terms of mapping, representation, processing, statistical and spatial 

analysis,showing the abilities and the function of using GIS in general and in 

floods hazard specifically, Develop a multilayer geo- database for the study area to 

design an early warning system for floods of Alsalha–algeaa, and Applying  tools 

of GIS tools analysis to determine  flood risks , and Provide authorities and 

decision makers with flood hazard thematic maps and reports , and Increase the 

awareness ofthe publics for the hazards of floods and its danger. 
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1.6 Research Scope 
 

 The implementation of this project is planned for the city of Omdurman 

Alsalha-algeaa, the project data will be collected by the GIS technologies and 

using GIS tools - mapping analysis will deliver recommendations for emergency 

responses. 

 

1.7 Research  Methodology 
 

In this study, the descriptive and analytical method was used to use the 

information. The methodology was developed using spatial data, processing and 

application of spatial, statistical and data analysis techniques suitable for 

generating objective maps and reports on flood risks. Using spatial analysis to 

determine the level of study area, Affected and the assembly point of the affected 

area, and use network analysis to determine the shortest path from civil defense to 

the assembly point. In addition to identifying the nearest route from the assembly 

point to the nearest hospital. 

 

1.8  Organization of the Thesis 

 

There are Five chapters in this thesis; it is organized as follows: 

1. Chapter:2  contain  a literature review about  floods causes and effects  and GIS 

technology as well as summarizes related work, which are papers with  regard 

to  this thesis 

2. Chapter:3 describe the case study and design geo-database  used in data 

collection and analysis for spatial and statistical analysis. 
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3. Chapter:4 contain implementation and determine the affected areas of floods. 

Using Simulation models on the computer would enable decision makers to 

show the results and feasibility and how to use analysis and result. 

4. Chapter:5 provide conclusions and recommendations for future works with 

discussion. 
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Chapter Two 

 

Theoretical Background And 

Literature  Review 
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2.1 Natural disaster 

Disaster is an accident caused by the forces of nature, or by human action, 

resulting in loss of life and destruction of property, and has a severe impact on the 

national economy and social life.one example is flood. 

2.1.1 Definition of floods 

Floods are defined as extremely high flows or levels flood water of rivers, 

lakes, ponds, reservoirs and any other water bodies, whereby water inundates 

outside of the water bodies area. 

Flooding also occurs when the sea level rises extremely or above coastal 

lands due to tidal sea and sea surges. In many regions and countries floods are the 

most damaging phenomena that effect to the social and economiclife of the 

population 

2.1.2 Causes of Flooding 

In general, many reasons increase flooding in many parts of the world such 

as: Climatologically events ,Changes in land use and increasing population,  

Land subsidence, Tsunami and  Dam & Levee Failures. 

2.1.3 The characteristics and related hazards 

The dangers of floodwaters are associated with a number of different 

characteristics of the flood:  Depth of water ,Duration , Velocity , Sediment load  

and Rate of rise , and  Frequency of occurrence 
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2.1.4 Effects of Floods 

The effect of a flood can be catastrophic, All these things can happen: 

Broken roads and railway lines, Demolished houses and displaced thousands of 

people and made them homeless, Spoilage of farms and agricultural crops, The 

electricity and gas supplies are cut off and Diseases , and Disruption of means of 

transportation ,People and animals are killed , Electrical items like computers and 

TV  can be damaged and Bridges break and Lose luggage 

2.1.5 Benefits of Floods 

The floods have many losses andonly  few benefits :River floods feed 

groundwater reservoirs , and Fill the land with water, which makes fertile land 

suitable for agriculture and this helps to flourish agricultural activity in the 

world. 
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(a)                                  (b) 

 
(c) 

 

 
(d )                                              (e) 

 

Figure (2.1) Effects of Floods   (a, b, c, d ,e)  
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2.1.6 Sudan floods 

In the Sudan, as mostother countrieswhich have been hit by floods many 

times, from time to time and in different amounts, some of them were heavy 

floods.The most recent heavy floods were in August 2013 which hit Khartoum, the 

capital.These floods caused massive destruction in infrastructure and destroyed 

most of the houses and made many families homeless. 

 The destruction caused by these floods requires assistance, from some of 

countrieswhom delivered shelters, food and some other basic needs of  the affected 

families. 

In July 2016 floods have destroyed 1,160 houses and damaged another 1,320 

homes. The UN Office for the Coordination of Humanitarian Affairs (OCHA) 

reported in a bulletin last week. Around 15,000 people have been affected. 

The floods occurred in Singa, the capital of Sennar State. In response, Civil 

Defense and Sudanese Red Crescent Society (SRCS) have unblocked drainage 

networks, relocated affected people and distributed sandbags to protect from 

flooding, (by Richard Davies in Africa news). 

In 2016 for example in general Sudan was hit by major floods causing the 

collapse many housesof either totally or partially. 

Torrential rains caused major damage to the lives and property, killing 76 

people in 13 states, collapsing more than 300 homes in all, andeffecting more than 

1,000 others in Kassala, North Darfur and the island, and also caused severe 

damage to a group of villages, and flooded the water for about 6 thousand acres, as 

a result of successive rainfall, as well as torrential flows from the plateau of 

western Sinnar. 
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Table (2.1) of disaster damage, rain and floods in the Sudan 18 July 2016 Source: 

operational mechanism to prevent the effects of the floods and torrential rains of 

2016. 

Table (2.2) of disaster damage 

Unit No Item 

The total collapse of housing 541 House 

Partial collapse of housing 698 House 

The number of deaths Over 100 People 

The number of casualties of 302 People 

The cultivated areas lost 1011573 Acres 

 
 
2.1.7 Floods in the Alsalha-algeaa Area 

 
 On Aug 3, 2014the total number of homes that was collapsed completely 

876 houses, while 720 houses were partially collapsed, along with 16 drowning 

deaths due to the power of the water rush. In addition that the area is in a state of 

suffering and lacks a lot of needs, including tents, radiators and blankets beside bed 

nets, as well as eating and drinking problems related due to lack of bread. 

 And it resulted in the destruction of a number of bakeries along with the lack of 

household utensils that disappeared amid the rubble of houses. Thus  the 

emergency room  have taken upon themself to provide small meals for the 

affected, but it could not meet the needs of all, calling organizations together to 

overcome this disaster Especially organizations and associationsworking in the 

medical field in anticipation of diseases, that may result from such disasters 

(Khartoum electronic media center ) 

 



01 
 

 
(a)                                               (b) 

 

 
 (c)                                       (d) 

Figure (2.3) 

 

 

Figure (2.2), (a,b) Effected Area in Case Study Alsalha-algeaa,2014 

(c,d)  Alsoog- alarabe, Tunnel of Omdurman- The Great Alftihab, 2018  
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2.2 Geographical Information Systems (GIS) 

GIS is defined as a system of hardware, software, data, people, organizations 

and institutional arrangements for collecting, storing, analyzing, and disseminating 

information about areas of the earth [1] 

GIS is defined as follows 

An integrated spatial database management system using database technology and 

spatial databasesor A computer-based system comprising one or more databases 

together with a set of tools for collecting (capturing) ,storing, checking, editing, 

retrieving, integrating, manipulating, transforming, analyzing and displaying 

geographical referenced dataother defined , A powerful set of tools for collecting, 

storing, retrieving at will, transforming and displaying spatial data from the real 

world for a particular set of purposes. 

 

2.2.1 ArcGIS Definition 

 ArcGIS is a geographic information system (GIS)software  for working with 

maps and geographic information. It is used for creating and using maps, 

compiling geographic data, analyzing mapped information, sharing and 

discovering geographic information, using maps and geographicinformation in a 

range of applications, and managing geographic information in a data base.  

The software provides an infrastructure for making maps and geographic 

information available throughout an organization, across a community, and openly 

on the Web. 
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2.2.1.2 ArcGIS includes the following Windows desktop software 

 
Arc Reader, which allows one to view and query maps created with the other 

ArcGIS products; ArcGIS for Desktop, which is licensed a follows 

2.2.1.3 Functionality levels 

 
ArcGIS for Desktop Basic (formerly known as ArcView), which allows one to 

view spatial data, create layered maps, and perform basic spatial analysis; 

 And ,ArcGIS for Desktop Standard (formerly known as Arc Editor), which in 

addition to the functionality of ArcView, includes more advanced tools for 

manipulation of shape files and geo databases; and ArcGIS for Desktop Advanced 

(formerly known as Arc Info), which includes capabilities for data manipulation, 

editing, and analysis. 

There are also server-based ArcGIS products, as well as ArcGIS products 

for PDAs. Extensions can be purchased separately to increase the functionality of 

ArcGIS 

2.2.2 Geography 

 

Geography is broadly concerned with understanding the world and man‘s 

place in it. Geography has a long tradition in spatial analysis. The discipline of 

geography provides techniques for conducting spatial analysis and a spatial 

perspective on research [2]. 

2.2.3 Cartography 

 

 Cartography is concerned with the display of spatial information. Currently 

the main source of input data for GIS is maps. Cartography provides a long 

tradition in the design of maps which is an important form of output from GIS. 

Computer cartography (also called ‗digital cartography‘, ‗automated cartography‘) 
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provides methods for digital representation and manipulation of cartographic 

features and methods of visualization. 

2.2.4 Benefits of GIS 

 

Automating map making and updating, and  Providing a unified database, and 

Linking location and descriptive attributes of feature(s) ,and Manipulating & 

analyzing Geographic Information in ways that are not possible manually and 

Higher accuracy, higher costs 

 
2.2.5 GIS Advantage over Maps 

2.2.5.1 Data Storage 
 

Spatial data stored in digital format in a GIS allows for rapid access for traditional 

as well as innovative purposes, The nature of maps creates difficulties when used 

as sources for digital data, and Most GIS take no account of differences between 

datasets derived from maps at different scales. 

2.2.5.2 Data Indexes 
 

This function can be performed much better by GIS due to the ability to 

provide multiple and efficient cross-referencing and searching. 

 

2.2.5.3 Data Analysis Tool 
 

GIS is a powerful tool for map analysis, and Traditional impediments to the  

accurate and rapid measurement of area or to map overlay no longer exist. 

 

2.2.5.4 Data Display Tools 

 

Electronic display offers significant advantages over the paper map , Ability to 

browse across an area without interruption by map sheet boundaries, and Ability to 

zoom and change scale freely, and Potential for the animation of time dependent 
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data, and Display  in three dimensions‖ (perspective views),with  in real-time , 

Rotation of viewing angle, and Potential for continuous scales of intensity and the 

use of color and shading , then Independent of the constraints of the printing 

process, ability to change colorsas required for interpretation. 

2.2.5.5 GIS Data Models 

 

 

Figure (2.4)The GISlayers Models 

2.2.6 Vector-based 

 
 The geographic features are points, lines and polygons (areas), the features 

are discrete. In the vector format, the river is represented by an actual line with 

geographic coordinates, while the trees can either be represented as an area that 

surrounds the tree stand, or as individual points representing trees. Storing the 

geographic coordinates for these features provides great flexibility for use in a GIS. 

 

2.2.6.1 Raster-based 

 
The geographic features are represented as a matrix/grid of values. The 

values equally spaced across a surface. The raster representation of the real world 

objects is limited by the size of the grid cells. Therefore, the river is coded as a 
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series of grids with the letter B, while the trees are codes as a series of grid cells 

with the letter G. 

 

2.2.6.2 Raster Representation of Data 

  
Raster data is an abstraction of the real world where spatial data is expressed 

as a matrix of cells or pixels, with spatial position implicit in the ordering of the 

pixels. Each cell within this matrix contains location coordinates as well as an 

attribute value. With the raster data model, spatial data is not continuous but 

divided into discrete units. This makes raster data particularly suitable for certain 

types of spatial operation, for example overlays or area calculations[3]. 

 

2.2.6.3 Three Views of GIS 

 
Many have characterized GIS as one of the most powerful of all information 

technologies, because it focuses on integrating knowledge from multiple sources 

and creates a crosscutting environment for collaboration. In addition, GIS is 

attractive to most people who encounter it because it is both intuitive and 

cognitive. It combines a powerful visualization environment with a strong analytic 

and modeling framework that is rooted in the science of geography. This 

combination has resulted in a technology that is science-based, trusted, and easily 

communicated across cultures, social classes, languages, and disciplines. To 

support this vision, GIS combines three fundamental aspects or views [4]. 

 
2.2.6.4The Geo-database View 

 
A GIS manages geographic information. One way to think of a GIS is as a 

spatial database containing datasets that represent geographic information in terms 

of a generic GIS data model— features, raster, attributes, topologies, networks, and 
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so forth. GIS datasets are like map layers; they are geographically referenced so 

that the overlay onto the earth's surface. In many cases, the features (points, lines, 

and polygons) share spatial relationships with one another. For example, adjacent 

features share a common boundary. Many linear features connect at their 

endpoints. Many point locations fall along linear features (e.g., address locations 

along roads) [4]. 

 
2.2.6.5The Map View 
 

 A GIS is a set of intelligent maps and other views that show features and 

feature relationships on the Earth's surface. Various map views of the underlying 

geographic information can be constructed and used as "windows into the 

geographic database" to support queries, analyses, and editing of geographic 

information. Each GIS has a series of two-dimensional (2D) and three-dimensional 

(3D) map applications.That provides rich tools for working with geographic 

information through these views [4]. 

2.2.6.6The Geo-processing view 
 
 A GIS is a set of information transformation tools that derive new 

information from existing datasets. These geo-processing functions take 

information from existing datasets, apply analytic functions, and write results into 

new derived datasets. Geoprocessing involves the ability to string together a series 

of operations so that users can perform spatial analysis and automate data 

processing  all by assembling an ordered sequence of operations. 
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Figure(2.5)three views of GIS 

 
 
2.2.7 Kinds of GIS Analysis 

 
There are many kinds of GIS analysis such as measurements, layer statistics, 

queries, proximity analysis, filtering the raster data, buffering vector data, map 

overlay, transformation and reclassification. 

 

2.2.7.1Spatial Data Analysis 
 

Spatial analysis is a term widely used in the Geographical Information 

Systems (GIS) and Geographical Information Science. A definition of spatial 

analysis is that it represents a collection of techniques and models that explicitly 

use the spatial referencing associated with each data value or object that is 

specified within the system under study. Spatial analysis methods need to make 

assumptions about or draw on data describing the spatial relationships or spatial 

interactions between cases. The results of any spatial analysis are not the same 

under re-arrangements of the spatial distribution of values or reconfiguration of the 

spatial structure of the system under investigation [5]. 
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2.3 Remote Sensing 

 This emerging technique which records images from space and the air is a 

major source of geographical data. Remote sensing includes techniques for data 

acquisition and processing anywhere on the globe at low cost. and consistent 

update potential. The main advantage of it is that interpreted data from a remote 

sensing system can be merged with other data layers in a GIS 

2.4 Photogrammetry 

 Using aerial photographs and techniques for making accurate measurements 

from them, photogrammetry is the source of most data on topography (ground 

surface elevations) used for input to GIS [3]. 

2.5 Global Positioning System (GPS) 

 Is a satellite navigation system that provides location and time information 

in all weather conditions anywhere on or near the Earth where there is an 

unobstructed line of sight for four or more GPS satellites. The system provides 

important capabilities for military, civil and commercial users worldwide. The US 

government has created the system, maintains it and has made it free for anyone 

with a GPS receiver 

2.6 Surveying 

 Surveying is concerned with the measurement of locations of objects on the 

Earth’s surface, particularly property boundaries. Surveying provides high quality 

data on positions of land boundaries, buildings, etc.  
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2.7 Related Works 
 

- Flood Hazard and Risk Assessment in Chamoli District, Uttarakhand 

Using Satellite Remote Sensing and GIS Techniques 

Floods are a major environmental problem in India and have devastating 

effects on life and property. The problem with this paper is that there are no maps 

that determine the risks of flooding and the absence of maps that assess risks at the 

landscape level. India is characterized by spectacular landscapes and floods have a 

negative impact.TheChamoli District, Uttarakhand, India covering total 

geographical area of 8030 km2. The study area lies between 30-31° N latitude and 

79-80° E longitude,  

The methodology   and the techniques usedare the visual interpretation 

techniques for the preparation of the plant maps.  A series of multiple temporal 

data for flooding was used to prepare the digital evaluation model. Geographic 

information systems were used in spatial analysis. 

The result of the researchers was the creation of a map that illustrated the 

areas affected by the floods. The areas were classified as very high, high, medium, 

low and very low. This classification contributes to reducing and reducing losses 

and contributes to minimizing the impact of floods. There are comparable areas in 

the Himalaya. 

- Applicationof RS & GIS in Flood Management A case Study  of  

Mongalkote  Blocks , Burdwan, West  Bengal 
 

Floods occur as a result of geophysical events that create an unexpected 

threat to human life, which negatively affects people and their well-being. 

Mongalkote Blocklies between 23°30′51″N to 23°40′37″N 
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Latitude 87°53′28″E to 88°49′12″E longitude. It extends over 364.90 sqkmarea and 

has a population, according to thecensus of 2001of 233,944 persons with the 

density of 641/sq km. 

The study areahas been mainly affected by two rivers Ajoy&KunurRiver. 

Due to flooding in thearea by Ajoy and KunurRiver water spillsover and the other 

causes are narrow riverchannel, over sedimentation of channel, lowrun-off, heavy 

rainfall and very lowelevation of this area. 

The problem ,Mongalkote Block  suffer floods  and the absence of structural 

measures for flooding, management, control and prediction and the absence of 

appropriate illustrations of maps in real-time torrents. 

The methodology and techniques used by the researchers in this paper are 

remote sensing and their ability to provide data in real time. Here GIS technology 

support mapping of submerged areas and assessing damage by integrating 

meteorological data, topographic data and land use data. Satellite data was used 

before and during after the disaster 

 The results of the researchers in this paper are maps of the floods used in 

real time and also  maps of flood forecasting, which helps in the structural 

measures of floods and management and control and thus can be mitigated by 

floods, preparedness and response speed 
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- GIS Database on Hydro-GeomorphologicDisaster  in Portugal  
 

Natural disasters are one of the most widespread phenomena in the world, 

and in Portugal there are many floods and landslides, where economic losses are 

not included and need to be reconsidered 

The problem in this paper is the absence of a geographic geomorphological 

database system, that monitors water disasters, identifies the type of disaster, the 

number of casualties and the others. 

The methodology for data collection and storage using an online multiuser 

database, a development was made on a LAMP platform, comprised of an Apache 

Webserver, a MySQL database engine and using the PHP programming language 

built on a Linux Server, tocollect data from mainstream newspapers and 

distributethem to most sites to cover the country and read these newspapers to 

analyze and convert data to digital data.  

The results of the researchers are the creation of a database that enables disaster 

monitoring, type, analysis, prediction and dissemination, The records of damage 

were also identified and the number of injured, missing and displaced persons was 

determined by floods or water disasters. 
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Chapter Three 

 

Design Geo-database 
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The Study Area  

 

3.  Descriptionof Study Area 

The study covers a selected part of the Alsalha-algeaa and areas around. 

 
3.1 Location 

Alsalha is located in the state of Khartoum in the south of the city of 

Abosyed Omdurman the southern countryside. It lies between [15°32‘0", 

15°31‘0"] latitude N , and [ 32°25‘0", 32°26‘0"] longitude E,  and in  the  East we 

find the Islamic University of Omdurman and in the North-West Mount Touraieh 

and the new airport in addition to the bridge dabasin,Figure [3.1]. 

 Its total area is estimated at 3.28 km2 and the Built Area is estimated at 

2.13 km2. 

 
 
 
 

Table (3.1) Area coordinates 

 

Point Easting Northing 

A 437918 1718740 

B 438337 1715309 

C 437163 1717263 

D 439477 1717342 
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Figure (3.1) Study Area 
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3.2  Ecology 

 
 The Study Area features a hot arid climate, with only the autumn months 

seeing noticeable precipitation. The city averages a little over 155 millimeters (6.1 

in) of precipitation per year 

 
3.2.1 Climate 

 
 The climate of the study area is semi-desert almost every months of the 

year except for the months of July and August, where rainfall 

occurs.TheOmdurman Alsalha-algeaaregion is considered one of the hottest cities 

in the world, with a temperature exceeding 53 ° C (127 ° F). The average annual 

temperature is 37 ° C (99 ° C) ° F) with six months of the yearand at least an 

average monthly temperature of 38 ° C (100 ° F). It is noted that the temperature 

drops significantly during the night to reach about 15 ° C (59 ° F). 

 
3.2.2Topography 

 

The study area topography is a plain surface gently sloping towards the White Nil 

and River Niles, generally elevated between 400 to 380 m above mean sea level 

the area is regarded as semi-arid zone. The drainage system is dominated by the 

lower most reaches of the White Nile, River Nile and local systems of ephemeral 

streams (e.g. Wadis and Khors) Figure (3.2) 
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Figure (3.2)Topography of study Area  
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3.2.3 Old Channels and Wadies 

 

 The area of Alsalha-algeaa is characterized by the existence ofWadi or 

Khor on the western side, which extends East to reach the Nile River, called the 

region of (Toti), the khoris a long and narrow depression  formed as a result of 

erosion, a natural drainage of rain . 

 
3.2.4 Soil  

 In terms of geological composition, they are divided into three main 

sections: sedimentary formations, basic rocks and sandstone formations.Each of 

which has its characteristics which distinguish it from other structures. 

Sedimentary formations are the most common form in this region. 

 

3.2.5 Contours 

Work was done to see the nature of the earth and the terrain, in the steep 

north and southward the lowest slope Figure (3.3). 
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Figure (3.3) Algeaa Contours Line 
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3.2.6 Aspect  

Most of the region is heading east by 32%, followed by the southward slope 

of 27% and the north and west by 20%, calculated according to count pixel, see 

Figure (3.4). 
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Figure (3.4) Algeaa Aspect 
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3.3  Data Collection 

 
A field visit to the area was conducted, characterized as low-built and densely 

populated, andgathering coordinate and data using GPS navigator Figure (3.5)and 

Figure(3.6) and The map of buildings and roads has been obtained from the 

Khartoum State Survey Corporation (KSSC) with accuracy of about 2m   Figure ( 

3.7) then Digital Elevation Model (DEM):Space Shuttle Radar Topography 

Mission (SRTM) with 30 meter spatial resolution was used to determine the 

topographic characteristics of the study area, and Data obtained from the Nile 

Meteorological Authority Figure(3.8). 
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Figure (3.5) Point Civil Defense Location 
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Figure (3.6) Distribution of Hospital 
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Figure (3.7) Roads 
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 MINISTRY OF ENVIROMENT, FORESTRY  

AND PHYSICAL DEVELOPMENT  
METEOROLOGICAL AUTHORITY 

WEATHER – CLIMATE DATA 

Station: - KHARTOUM     

2012        2013                      2014                  2015 2016 2017 

ELEMENT Total 
Rainfall 
(Mm) 

Total 
Rainfall 
(Mm) 

Total 
Rainfall 
(Mm) 

Total 
Rainfall 
(Mm) 

Total 
Rainfall 
(Mm) 

Total 
Rainfall 
(Mm) 

 

Month 

 
January 

 
0.0 

 
0.0 

 
0.0 

 
0.0 

 
0.0 0.0 

 
February 

 
0.0 

 
0.0 

 
0.0 

 
0.0 0.0 0.0 

 
March 

 
0.0 

 
0.0 

 
0.2 

 
0.0 

 
0.0 0.0 

 
April 

 
0.0 

 
0.0 

 
TR 

 
0.0 0.0 0.0 

 
May 

 
0.0 

 
TR 

 
4.6 

 
0.0 0.0 1.4 

 
June 

 
TR 

 
0.0 

 
0.6 

 
TR 0.2 12.0 

 
July 

 
20.9 

 
14.4 

 
73.6 

 
0.4 14.2 24.0 

 
August 

 
57.7 

 
69.0 

 
52.3 

 
28.9 52.6 75.9 

 
September 

 
TR 

 
3.2 

 
29.4 

 
13.9 12.2 0.0 

 
October 

 
8.0 

 
0.2 

 
5.7 

 
29.3 TR   

 
November 

 
TR 

 
0.0 

 
0.0 

 
0.0 0.0   

 
December 

 
0.0 

 
0.0 

 
0.0 

 
0.0 0.0   

 
Total/annual 

 
86.6 

 
86.8 

 
165.8 

 
72.5 79.2 113.3 

Note :-         TR = Trace   

Figure (3.8) Weather Climate Data 
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3.4 Methodology 

 
After the selection of  the study area, the coordination of the coordinate 

systemunitsand the network of roads,were established by steps Converting 

numbered data into a layer within the ARC GIS program, finding the levels for the 

study area, finding the level of natural Nile, work of the topology of the road 

network 

And ,The work on topology of the Road Network to find and correct errors, 

according to the following rules:The line is not redundant or incomplete; two lines 

do not match one point. And do not intersect a line, and are looking for intersection 

errors and The geo-database has been created to store spatial data. 

,Other spatial data such as hospital location,civil defense point location, the road 

network, buildinglayer, are all stored in the geodatabase are used to conduct the 

spatial analysis and The digital evaluation model  of  the study area and contains 

the clip ,(Toolboxes → Data Management → Raster → Raster Processing → 

Clip),(Toolboxes → Data Management Tools → Features → Feature to Point) and 

,The levelswere extracted from the DEM, (Toolboxes→ Spatial Analyst Tools → 

Extraction → Extract Values to  Point) and To identify the affected areas which are 

below the Nile level during the floods, we follow the following steps of selection  

by attribute, the affected areas (below the Nile level) were identified from 

(Attribute → Table →Summarize), and To show the affected and unaffected areas 

and to calculate the areas and buildings affected by(Attribute → Calculate 

→Geometry → Area), and  After the treatments performed in the previous steps, 

many statistical and spatial analyses were conducted on the processed data. 

GatheringPointSpatial analysis was used to determine the level of the Study 

Area;from the meteorological level, the affected areas were calculated,then the 
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Gathering point for the affected areas, thegathering point have been determined 

(the intermediate point between the affected areas only). 

Toolbox→ Spatial Statistics Tools →Measuring Geographic Distribution → Mean 

Center. The nearest safe area was selected in the unaffected part to be the required 

gathering point, Toolbox → Analysis Tools → Proximity → Near. 

      ClosestPathTo determine the closest path from thecivil defense to thegathering 

point, from the Network Analysis tab, choose( New Route)  , after specifying the 

points (gathering point and civil defense) and pressing £ Solve. 

Closest Path to the NearestHospitalDetermine the closest path from the gathering 

point to the nearest hospital, through the (New Closest Facility) from the bar 

(NetworkAnalysis) because there are more than one hospital. Where the hospital 

layer is added to the facilities by 

Arc Toolbox → Network Analysis Tool → Analysis → Add Location 

The gathering point is selected from the Create Location Tool, then choose £Solve 

from spatial analysis tab. 

Flood Hazard Map It is one of the simulation models on the computer to 

identifythe affected at the height of the Nile level to 386m. Then a new layer for 

the affected areaswas created and there after the transfer the affected buildings in 

the new layer followed.  
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3.4.1 Prediction for 2019 

Defining the civil defense point of 2019 

The civil defense is one of the most important organs that specialize in the 

management of all preventive and precautionary factors and activities of the 

rescue and rescue operations through the intervention and rapid handling in an 

integrated manner with any emergency circumstances and reduce any negative 

effects of the disaster or mitigate them. The presence of civil defense is 

important in all areas to reduce the percentage of losses resulting from any 

disaster and avoiding the serious damage resulting from it. 

With the help of Microsoft Excel software using thefunction of forecasting 

aMathematical prediction has been done to estimate the flood in 2019 through 

the information ofthe meteorological agency of the previous seven years (2012-

2018). 
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3.4.2 Model of Geo-database  

 

 

 

 
 

 

 

 

Figure (3.9) Model of Geo-database 
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Chapter Four 

 

Result  And Discussion 
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4. Result 

4.1 The gathering point 2014 

 reduce lives as much as possible, a safe gathering point is chosen to 

transport the affected persons according to their necessary medical treatment  of 

the residential areas using the evacuation (the transfer of persons or Property 

from a danger zone or area at risk to safe places, the gathering point or the 

accommodation areas) Figure (4.1). 
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Figure (4.1) Gathering Point 2014 
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4.2 Closest path from Civil Defense to the gathering point 2014 

 

  One of the main points in saving lives and property is to reach the 

gathering point with the shortest route and the lowest possible time. Therefore, 

amap was produced showing the shortest route from the point of defense to the 

gathering point, Figure (4.2). 
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Figure (4.2) Closest Path from Civil Defense Location to the Gathering Point 2014 
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4.3 Closest Path from the Gathering to the Nearest Hospitals in 2014 

 

  To analyze the damages caused by the flood as much as possible and 

the response time needed for ambulance services, the nearest hospital was 

identified for the gathering point and the shortest path to reach it, Figure (4.3) 
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Figure (4.3)Closest Path from the Gathering Point to the Nearest Hospitals 2014 
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4.4 Flood Hazard Map2014 

 

 The goal of the hazard level map is to try to determine the affected 

areas based on descriptive and spatial data., The result distance the access to 

damaged and non-damaged areas, Figure (4.4), and we got the number of 

affected homes =892 &  The area of the affected houses=838.415 m2, and the 

total number of houses =3877. 
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Figure (4.4) Flood Hazard Map 2014 
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4.5 Predicted flood2019 

 

 Using the information of the meteorological agency for the 

previous seven yearsand using the prediction function of the Excel 

program and it result was that the expected rainfall rate for 2019 is = 

90.08 millimeters,seeFigure (4.5). 

 

 

 

 

 

 

Figure (4.5)Weather Predictions 2019 
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4.6 The gathering point 2019 

 

Figure (4.6) The Gathering Point for the Affected Areas 2019 
 

 

 

 



11 
 

 

4.7 Closest Pathfrom Civil Defense to the Gathering point 2019 

Figure (4.7)Closest Path from Civil Defense Location to the Gathering Point 2019 
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4.8 Closest Path from the Gathering to the Nearest Hospitals 2019 

 

Figure (4.8)Closest Path from the Gathering Point to the Nearest Hospitals 2019 
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4.9 Flood Hazard Map 2019 

 

 

Figure (4.9) Flood Hazard Map 2019 
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Chapter Five 

 

Conclusions and Recommendations 
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5.1 Conclusions 

 This study focused on the application of GIS in flood management and 

mitigation, especially in theAlsalh-algeaa area .The study concluded the following: 

Through the flood hazard map of 2019 we conclude that a decision can be 

made to minimize as much as possible the flood damage expected to occur in 

2019 by evacuating the population from areas expected to be exposed to flood 

risk or to make landings before the time of precipitation or other solutions ,and  

The use of the geospatial information environment reduces the time and effort 

in dealing with the floods at the time of its occurrence. In addition to the fact 

that geographic information systems enable the construction of representative 

models of the disaster scene, they are enabling the competent authorities to 

implement several scenarios and alternatives and applying them to the 

computer first and then study the most appropriate alternative on ground, and  

GIS is a suitable method for flood analysis and extensive use of these 

techniques contributes significantly to the creation of a long-term database that 

helps mitigate flood and relief affected, Provide authorities and decision 

makers with the created risk maps then Increase  the awareness of the  public  

for the risk of floods and its danger 
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5.2 Recommendation 

Develop new methods of mapping and monitoring of flooded areas and predicting 

possible extensions of the flood. Moreover an employment of geographic 

information systems is proposed to find solutions to mitigate flood risks ,  and 

Protecting thewadis and their streams from encroachments on them to use them as 

residences, estates and farms, and it may cause flood water reserves, flooding of 

valleys,for the last years, with the work of soil nature studies and mechanical 

properties, Construction and provision of rainwater drainage systems for 

citiesaccording to engineering and technical standards, The importance of 

cooperation with relevant and competent authorities in order to collect and monitor 

information on climatic conditions and the use of modern technologies such as 

satellites and GIS and early warning systems  and  train and qualify specialists in 

flood risk management and how to deal with them, then  Taking into account the 

protection of cities from the dangers of floods when studying the future 

urbanization of cities and communities, and giving low areas and locations within 

cities the importance of rain and flood drainage 
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Appendix 
 

# -*- coding: utf-8 -*- 

# --------------------------------------------------------------------------- 

# python.py 

# Created on: 2018-09-16 01:22:49.00000 

#   (generated by ArcGIS/ModelBuilder) 

# Usage: python 

<StudyArea_FeatureToPoint><polygon_algeaa_shp><polygon_algeaa__3_><Extr

act_StudyAr1__3_> 

# Description:  

# --------------------------------------------------------------------------- 

 

# Set the necessary product code 

# import arcinfo 

 

 

# Importarcpy module 

importarcpy 

 

# Check out any necessary licenses 

Arcpy.CheckOutExtension("spatial") 

arcpy.CheckOutExtension("Network") 

 

# Script arguments 

StudyArea_FeatureToPoint = arcpy.GetParameterAsText(0) 

if StudyArea_FeatureToPoint == '#' or not StudyArea_FeatureToPoint: 

    StudyArea_FeatureToPoint = 

"C:\\Users\\meinas\\Documents\\ArcGIS\\Default.gdb\\StudyArea_FeatureToPoint

" # provide a default value if unspecified 

 

polygon_algeaa_shp = arcpy.GetParameterAsText(1) 

ifpolygon_algeaa_shp == '#' or not polygon_algeaa_shp: 

polygon_algeaa_shp = "D:\\2019\\shapefile\\polygon_algeaa.shp" # provide a 

default value if unspecified 

 

polygon_algeaa__3_ = arcpy.GetParameterAsText(2) 

if polygon_algeaa__3_ == '#' or not polygon_algeaa__3_: 

    polygon_algeaa__3_ = "polygon_algeaa" # provide a default value if 

unspecified 
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Extract_StudyAr1__3_ = arcpy.GetParameterAsText(3) 

if Extract_StudyAr1__3_ == '#' or not Extract_StudyAr1__3_: 

    Extract_StudyAr1__3_ = "Extract_StudyAr1" # provide a default value if 

unspecified 

 

# Local variables: 

Extract_StudyAr1 = StudyArea_FeatureToPoint 

N15E032_hgt = "D:\\floods_2\\DEM\\N15E032.hgt" 

Extract_StudyAr1__2_ = "Extract_StudyAr1" 

Polygon_algeaa_Select = polygon_algeaa__3_ 

polygon_algeaa_Select_MeanCe = polygon_algeaa_Select 

polygon_algeaa = "polygon_algeaa" 

algeaa_2019_ND = "algeaa_2019_ND" 

facilities_1 = "facilities_1" 

algeaa_2019_ND__2_ = "algeaa_2019_ND" 

Closest_Facility_4 = "Closest Facility 4" 

Closest_Facility_4__4_ = "Closest Facility 4" 

Route__2_ = "Route" 

Route__7_ = "Route" 

 

# Process: Feature To Point 

arcpy.FeatureToPoint_management(polygon_algeaa_shp, 

StudyArea_FeatureToPoint, "CENTROID") 

 

# Process: Extract Values to Points 

arcpy.gp.ExtractValuesToPoints_sa(StudyArea_FeatureToPoint, N15E032_hgt, 

Extract_StudyAr1, "NONE", "VALUE_ONLY") 

 

# Process: Select Layer By Attribute 

tempEnvironment0 = arcpy.env.extent 

arcpy.env.extent = 

"C:\\Users\\meinas\\Documents\\ArcGIS\\Default.gdb\\Extract_StudyAr1" 

arcpy.SelectLayerByAttribute_management(Extract_StudyAr1__2_, 

"NEW_SELECTION", "RASTERVALU <382") 

arcpy.env.extent = tempEnvironment0 

 

# Process: Select Layer By Location 

arcpy.SelectLayerByLocation_management(polygon_algeaa, "INTERSECT", 

Extract_StudyAr1__3_, "", "NEW_SELECTION", "NOT_INVERT") 
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# Process: Select 

arcpy.Select_analysis(polygon_algeaa__3_, polygon_algeaa_Select, "") 

 

# Process: Mean Center 

arcpy.MeanCenter_stats(polygon_algeaa_Select, polygon_algeaa_Select_MeanCe, 

"", "", "") 

 

# Process: Make Closest Facility Layer 

arcpy.MakeClosestFacilityLayer_na(algeaa_2019_ND, "Closest Facility 4", 

"Length", "TRAVEL_TO", "", "1", "", "ALLOW_UTURNS", "", 

"NO_HIERARCHY", "", "TRUE_LINES_WITH_MEASURES", "", 

"NOT_USED") 

 

# Process: Add Locations 

arcpy.AddLocations_na(Closest_Facility_4, "Facilities", facilities_1, "Name Name 

#", "5000 Meters", "", "Road_1 SHAPE;facilities_1 

SHAPE;algeaa_2019_ND_Junctions NONE", "MATCH_TO_CLOSEST", 

"APPEND", "NO_SNAP", "5 Meters", "INCLUDE", "Road_1 #;facilities_1 

#;algeaa_2019_ND_Junctions #") 

 

# Process: Solve (2) 

arcpy.Solve_na(Closest_Facility_4__4_, "SKIP", "CONTINUE", "5 Meters") 

 

# Process: Make Route Layer (2) 

arcpy.MakeRouteLayer_na(algeaa_2019_ND__2_, "Route", "Length", 

"USE_INPUT_ORDER", "PRESERVE_BOTH", "NO_TIMEWINDOWS", "", 

"ALLOW_UTURNS", "", "NO_HIERARCHY", "", 

"TRUE_LINES_WITH_MEASURES", "") 

 

# Process: Solve (3) 

arcpy.Solve_na(Route__2_, "SKIP", "TERMINATE", "5 Meters") 

 

# Process: Make Route Layer (3) 

arcpy.MakeRouteLayer_na(algeaa_2019_ND, "Route", "Length", 

"USE_INPUT_ORDER", "PRESERVE_BOTH", "NO_TIMEWINDOWS", "", 

"ALLOW_UTURNS", "", "NO_HIERARCHY", "", 

"TRUE_LINES_WITH_MEASURES", "") 

# Process: Solve (4) 

arcpy.Solve_na(Route__7_, "SKIP", "TERMINATE", "5 Meters") 
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